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1. PREFACE 
 
1.1. GENERAL 
 
You have made a good choice in selecting a KEMPPI product. Properly installed and 
used, Kemppi products prove to be productive machines requiring only a small 
amount of maintenance.  
 
This manual gives you a thorough understanding of the equipment. Read the manual 
carefully through before installing, operating, or maintaining the equipment for the 
first time. Pay extra attention to the warnings and the Operation safety section and 
follow their instructions at all times. 
 
For further information on Kemppi products please contact your nearest Kemppi 
distributor or Kemppi Oy. 
 
The specifications and designs presented in this manual are subject to change without 
a prior notice. 
 
 
1.2. PRODUCT INTRODUCTION 
 
Kemppi DataMaster II is a general-purpose programming toolkit. It consists of the 
DataMaster II programming box, cables, battery charger and the PC Software.  
 
1.2.1. Memory function compatibility 
• The full range of functionality is available with MTM control panel. 
• Works also with the MTL and MTX panels, but without the memory functions 

(only setup and panel setting can be set). 
 
1.2.2. Programming function compatibility 
• Kempact Pulse: Power Source/Panel. 
• Kempact Automotive: Power Source/Panel. 
• MasterTig ACDC MLS: Power Source/Panel. 
• MasterTig MLS: Power Source/Panel. 
• Pro. 
• AC/DC. 
• FastMig product family. 
• WeldForce:  Power Source/Panel. 
• DataMaster I/II. 
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1.3. OPERATION SAFETY 
 
Please read these safety instructions carefully and follow them when installing, 
operating, and servicing the machine. 
 
Battery safety instructions 
1. Do not dispose of the battery in a fire. The cell may explode. Dispose of batteries 

according to local regulations. 
2. Do not open or mutilate the battery. Released electrolyte is corrosive and may 

cause damage to eyes or skin. May be toxic if swallowed. 
3. Discard worn out battery as soon as possible. Worn out batteries are more likely 

to leak. 
4. Do not store this product or its battery in high temperatures. If batteries are stored 

in a freezer or refrigerator in order to extend their shelf life, they should be 
stabilised in room temperature prior to use. 
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2. INSTALLATION 
 
2.1. UNPACKING THE PRODUCT 
 
The product is transported in a durable, recyclable package. After unpacking, you 
should check the contents to make sure that nothing has been damaged during the 
transportation.  
 
Make also sure that the delivery corresponds to your order and that the delivery 
contains all the necessary instructions for installing and operating the equipment.  
 
 
2.2. OPERATING ENVIRONMENT 
 
When using the DataMaster II toolkit, do not expose the device to rain and direct 
sunshine. 
 
 
2.3. SERIAL NUMBER 
 
The serial number of the device is marked on the product plate. The serial number is 
used to identify the parts of a specific product. It is important to know the serial 
number of the device when ordering repair service or spare parts for the product. 
 
 
2.4. INSTALLATION AND MAIN PARTS 
 
2.4.1. DataMaster II keypad 
 

 
 
 

1. Left selection key. 
2. Enter key (alternative select/start 

key). 
3. Cancel/backspace key.  

Long press moves to the beginning 
of a menu. 

4. A-F special function keys. 
5. LCD display. 
6. Right selection key. 
7. Up and down arrow keys. 
8. ON/OFF key and RESET key. 
9. Standard number keypad. 
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2.5. CABLE CONNECTIONS 
 
2.5.1. DataMaster II connectors 
 
 

 
 
 
• RS-232 PC connector. 
• DC 12V power connector (12V 600mA). 
• PRO/CAN bus connector 
• ISP/SCI connector. 
• USB connector for PC. 
 
 
PRO/CAN connector  
 
To PRO/CAN connector you can connect e.g. the following machines: 

• FastMig™ Synergic 
• FastMig™ Basic 
• Pro and Pro Evolution products 
• WeldForce™ Power source 

 
 
ISP/SCI connector 
 
To ISP/SCI connector you can connect e.g. the following machines: 

• MasterTig 2300 ACDC 
• MasterTig MLS™ 2000, 3000,4000 
• Master MLS™ 1600, 2500, 3500 
• Kempact Pulse 3000, 2800 
• MinarcTig™ 
• MasterTig 2000, 2500, 3500 AC/DC (with adapter #4302380) 
• DataMaster, DataMaster II 
• WeldForce™ Panel’s 
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2.5.2. Renesas programming connection 
A 10-pin flat cable connector should be used when programming welding machines 
using a Renesas microcontroller.  
 
2.5.3. MasterTig MLS programming connection 
MLS must be connected to panel or power source by using 10-pin flat cable. 
 
2.5.4. MasterTig MLS calibration connection 
The same 10-pin connector can be used also for programming and calibration. 
 
2.5.5. Mastertig AC/DC programming connection 
A 10-pin flat cable connector with AC/DC adapter should be used when updating an 
AC/DC machine. 
Adapter number: 4302380 
 
2.5.6. PRO connection 
A PRO/CAN cable with a PRO/CAN connector should be used when updating the 
PRO program. 
 
2.5.7. CAN connection 
A PRO/CAN cable with a PRO/CAN connector should be used when updating the 
FastMIG program. 
 
A 10/7-pin cable should be used when updating a FastMig™ Basic machine. 
Cable number: 4298790 
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2.5.8. AC/DC connection 
When updating the AC/DC program the DataMaster II AC/DC adapter must be 
connected to a 10-pin flat cable according to the following picture. The adapter must 
be connected to AC/DC programming interface. 
 

 
 
2.5.9. FastMig™ connection 
The PRO/CAN cable with a DataMaster II PRO connector should be use when 
updating the FastMig™ program. 
 
2.5.10. PC connection 
The DataMaster II device can be connected to a standard PC via RS-232 or USB 
connection. For the USB connection you need a virtual COM port driver, but no 
driver is needed for the RS-232 connection. If both RS-232 and USB ports are 
connected in the PC, only the USB port will work. 
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2.6. INSTALLING THE SOFTWARE 
 
2.6.1. Installing the DataMaster II PC software 
 
1. Insert the DataMaster II CD in your computer's CD-ROM drive. 

 
The opening screen is displayed. If it doesn't appear, open the CD-ROM folder 
on your computer and double-click the Install.exe file. 

 

 
 
2. Click Install PC Software on the opening screen to start the installation of 

DataMaster II PC software.  
 
The Choose Destination Location dialog box is displayed. 
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3. Choose the destination folder for the DataMaster II software and click Next. 

 
The Select Program Folder dialog box is displayed. 
 

 
 
4. Select the program group for the DataMaster II program icon. 
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2.6.2. Installing the virtual COM port driver 
 
The virtual COM port driver is needed when the USB port is used in DataMaster II. 
The USB port is shown as COM port in the PC. The virtual COM port driver is also 
compatible with other Kemppi products, such as DLI 6.  
 
The virtual COM port driver can be also downloaded from the site 
http://www.ftdichip.com/Drivers/VCP.htm (device: FT232BM). 
 
 
Windows 2000/XP: 
 
1. Insert the DataMaster II CD in your computer's CD-ROM drive. 
2. Click Install USB Virtual COM Port Driver  option in the opening screen. 
3. Restart the computer. 
 
Windows 98/ME: 
 
1. Connect the DataMaster II to your computer and turn on the DataMaster II 

device. Windows detects a new device automatically. 
2. Enter the path where the virtual COM port driver is located. The installation 

starts. 
3. When the installation is complete, restart the computer. Now the DataMaster II 

COM port is displayed in the COM ports list with the first free port number. 
4. DataMaster II will use the installed COM port number only in the USB port 

where it was connected during the driver installation. If you want to use another 
USB port, you need to do the installation again. 

 
2.6.3. Uninstalling the virtual COM port driver 
Virtual COM port driver can be uninstalled by using the FTDIUNIN.EXE program, 
which removes the virtual COM port driver automatically from the computer. 
 
2.6.4. RS-232 port 
No installation is needed when using the RS-232 port. 
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3. DATAMASTER II PC SOFTWARE 
 
3.1. Supported file types 
 
DataMaster II PC software supports the following file types: 
• MLS (ST7): *.HEX, *.S19 and *.BIN 
• PRO (INTEL): *.HEX and *.BIN 
• AC/DC (INTEL): *.BIN and *.HEX 
• EEPROM (ST7) and setup function: *.MEM.  
• Renesas (RENESAS): *.MOT and *.BIN. 
 
  
3.2. Editing DataMaster II memory content 
 
3.2.1. Starting the DataMaster PC software 
 
When DataMaster PC software is started for the first time, the Settings dialog box is 
displayed where the user is asked to select the COM port, the communication speed 
(baud rate) and the language of the interface. 
 
Decreasing the communication speed makes the communication more reliable, but 
the communication speed between PC and DataMaster II will be slower. 
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3.2.2. Reading the memory content 
 
1. Start the DataMaster II PC software on your computer and turn on the 

DataMaster II device. The following screen is displayed. 
 

 

 
 

2. Click Device Program Management.  
 
DataMaster II will send the memory content to your computer, and following 
content list is displayed on your computer. 
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3.3. Sending data from PC to DataMaster II 
 
3.3.1. Sending program code to DataMaster II 
 
After reading the memory contents from DataMaster II to your PC you must select 
the memory block to be used. 
 
Click Send Program option in the content list and then select the program you want 
to send to DataMaster II. When you have made the selection, the Program info 
dialog box for that program is displayed. 
 

 
 
 
Dialog fields: 
 
Type: 
This field shows the type of the selected program. The type of program tells which 
machines can use it. 
 
Info: 
This field shows more information about the program. 
 
Program size: 
This field shows the program size. PC program also check that selected program 
current size to selected memory block. If the size is incorrect the PC program will 
give error message. 
 
Nr. programming limit: 
In this field user can define, how many times the selected program can be transferred 
from DataMaster II to a welding machine. If 'unlimited' is selected, there is no limit. 
If '1' is selected, the program can be transferred only once to a welding machine. 
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When OK key is pressed, the transfer of the program from the PC to the DataMaster 
II memory begins, and a dialog box appears showing the progression of the transfer 
process. 
 

 
 
During the transmission the message 'Receiving Data' is shown on the DataMaster II 
display. 
 
 
3.3.2. Erasing DataMaster memory block 
 
Click Erase memory block of DataMaster box option in the content list to erase 
the selected memory block in DataMaster II device. 
 
A confirmation dialog box appears. Select 'Yes' to continue the erasing of the 
memory block. 
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3.4. MASTERTIG MLS MEMORY FUNCTIONS 
 
3.4.1. Setting MTM panel memory channels on your PC 
 
Panel memory settings and setup settings are always transmitted together. This 
prevents conflicts between memory and setup. 
 
1. In MTM PANEL SETUP/MEMORY MANAGEMENT  select one of the 

following: 
• Select New if you want to define a new set of memory values.  
• Select Receive if you want to load memory settings from DataMaster II or the 

control panel. 
• Select Open if you want to load memory settings from a file on your PC. 
 

 

 
 
The following control panel simulation screen appears on your PC for you to define 
the memory values.  
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2. You can set the panel values directly to the panel simulation screen, or you can 

set the values by typing them into the fields on the right pane of the screen. 
 
3. When the correct values have been set, select the desired memory channel 

number and press SAVE key in the panel simulation. This does not save the 
values to your PC. To save the values to your PC you must choose File > Save. 
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3.4.2. Transmitting memory and setup values to DataMaster II or panel 
 
1. Select Tools > Transmit. 
 
The following memory selection table appears. 
 

 
 
2. Select 10 memory channels to be transmitted to the DataMaster II device or to 

the control panel. You can select any of the 100 channels, also empty ones. The 
red number in CH column shows the corresponding number in panel memory. 

3. Select Transmit to DataMaster II , if you want to send the values to DataMaster 
II, or select Transmit to Panel, if you want to send the values directly to the 
welding machine's control panel. 
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3.5. MASTERTIG MLS SETUP FUNCTIONS 
 
Panel memory settings and setup settings are always transmitted together. This 
prevents conflicts between the memory and setup 
 
3.5.1. Setting up the MTM panel Setup values on your PC 
 
1. In MTM PANEL SETUP/MEMORY MANAGEMENT  select one of the 

following: 
• Select New if you want to define a new set of setup values.  
• Select Receive if you want to load setup values from DataMaster II or the 

control panel. 
• Select Open if you want to load setup values from a file on your PC. 

 

 
 
The following setup view appears on your PC for you to define the setup values.  
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2. Select View > Setup view, and the first list of setup jumpers is displayed on the 

screen. 
• Right pane shows all the MTM panel jumper settings. 
• Left pane shows more detailed information about the jumper settings. 
• Jumper settings and values can be modified in both panes. 
• Left pane's contents change as you click different tabs. 

 
On Setup jumpers tab you can define jumper settings.  
On System settings tab you can define system values.  
On Minimum/Maximum settings tab you can set the adjustable panel value ranges.  
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3.5.2. Saving the memory and setup settings to PC 
 
Select File > Save As... if you want to save all panel and memory values to a hard 
drive on your computer. 
 
In Comment window you can write comments, which will also be saved to your PC's 
hard disk.  
 
 
3.6. Printing MasterTIG MTM panel values 
 
3.6.1. Printing the MTM panel values 
 
This procedure prints the panel picture and a list of all panel values. Setup values 
will not be included. 
 
1. Select the panel setting that you want to print. 
2. Select File > Print . 
3. Press OK . 
 
3.6.2. Printing the setup values 
 
This procedure prints all panel setup layer values. 
 
1. Select View > Setup View. 
2. Select File > Print . 
3. Press OK . 
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4. USING THE DATAMASTER II 
 
4.1. DATAMASTER II MENU 
 
When DataMaster II device is turned on, DataMaster II version information appears 
on the display. The DataMaster II main menu appears, when you press Menu key. 
 
You can navigate in DataMaster II menus with up and down arrows and make 
selections with Select or Enter keys. Pressing Cancel or backspace a few times will 
take you back to the main menu. 
 
The arrow symbols appear on the display only if there are more functions in that 
menu. 
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4.1.1. DataMaster II menu map 
                                bat:100% 
DATAMASTER II 
Software: 0A0 
                                     MENU

1                              bat:100% 
RENESAS 
FUNCTIONS 
                                SELECT

1-1                             bat:100% 
Renesas Programming 
Using UART mode 
 BACK                        SELECT

1-1-1        (34)           bat:100% 
Program 1                    (256Kb) 
(0A0 Kempact Panel               ) 
 CANCEL                     START

1-1-7        (0)             bat:100% 
Program 7                    (256Kb) 
( Empty                                   ) 
CANCEL                     START

1-1-8        (0)             bat:100% 
Program 8                    (128Kb) 
( Empty                                   ) 
CANCEL                     START

1-1-13       (0)             bat:100% 
Program 13                  (128Kb) 
( Empty                                   ) 
 CANCEL                     START

                                bat:100% 
Connect Programmable 
Device. 
 CANCEL             CONTINUE

                                 
Programming... 
done:100% 
  CANCEL

2                              bat:100% 
INTEL / PRO 
FUNCTIONS 
                                SELECT

2-1                             bat:100% 
Write Pro Program  

 BACK                        SELECT

2-1-1        (34)           bat:100% 
Pro Program 1       
(4297600B6 PRO Evolution     ) 
 CANCEL                     START

2-1-7        (0)             bat:100% 
Pro Program 7  
( Empty                                   ) 
CANCEL                     START

                                 
Programming... 
done:100% 
  CANCEL

1-3                             bat:100% 
Renesas Settings  

 BACK                        SELECT

1-3-1                          bat:100% 
Renesas Baud Rate 
Selection 
 BACK                        SELECT

1-3-1-1                       bat:100% 
Baud Rate: 9600  

 BACK                              SET

1-3-1-2                       bat:100% 
Baud Rate: 19200  

 BACK                              SET

1-3-1-3                       bat:100% 
Baud Rate: 38400 
(Selected) 
 BACK                              SET

1-3-1-4                       bat:100% 
Baud Rate: 57600  

 BACK                              SET

1-3-2                          bat:100% 
Set New ID Number  

 BACK                        SELECT

Write new ID Number 
Current ID Number: 
00 00 00 00 00 00 00 
 BACK                           SAVE

3                              bat:100% 
INTEL / AC/DC 
FUNCTIONS 
                                SELECT

3-1                             bat:100% 
Write AC/DC Program  

 BACK                        SELECT

3-1-1        (34)           bat:100% 
AC/DC Program 1       
(4283180C0 AC/DC                 ) 
 CANCEL                     START

3-1-6        (0)             bat:100% 
AC/DC Program 5       
( Empty                                   ) 
 CANCEL                     START

                                 
Programming... 
done:100% 
  CANCEL

                                 
Verifying... 
done:100% 
  CANCEL

(C) Cancel

(C) Cancel

BACK / 
(C) Cancel

BACK / 
(C) Cancel

BACK / 
(C) Cancel

BACK / 
(C) Cancel

(C) Cancel

(C) Cancel

(C) Cancel

(C) Cancel (C) Cancel(C) Cancel

MENU

Wait / 
(C) Cancel

Wait / 
(C) Cancel

BACK / 
(C) Cancel

1-2                             bat:100% 
Renesas Programming 
Using UART mode 
 BACK                        SELECT

                                 
Checking CAN Devices  
Wait... 
  CANCEL

DEVICE 0:                                
No Device  

  CANCEL

DEVICE 3:             PA001619                      
Panel 
00A2, Synergic 
  CANCEL            PROGRAM

DEVICE 15:                                
No Device  

  CANCEL

                                 
Programming:  57% 
Wait... 
  CANCEL

                (10)           
Program 1                    (256Kb) 
(SF,Syner,Panel,0A2              ) 
 CANCEL                     START

                (0)              
Program 13                  (128Kb) 
( Empty                                   ) 
 CANCEL                     START

                                
Programming  
Cancelled.! 

(C) Cancel

Program

(C) Cancel

(C) Cancel

                                 
Programming OK!  

                                        OK

OK

(C) Cancel

(C) Cancel

(C) Cancel
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4                              bat:100% 
ST7 / DC MLS 
FUNCTIONS 
                                SELECT

4-1                             bat:100% 
Write MLS Program  

 BACK                        SELECT

4-1-1        (NL)           bat:100% 
MLS Program 1       
(TIG Panel 0b0                        ) 
 CANCEL                     START

4-1-9        (0)              bat:100% 
MLS Program 9       
( Empty                                   ) 
 CANCEL                     START

                                 
Programming... 
done:100% 
  CANCEL

4-2                             bat:100% 
Copy MLS Program  

 BACK                        SELECT

4-2-1                          bat:100% 
Select DM Memory       
Channel: 1 (Saving) 
 CANCEL                      COPY

4-2-9                          bat:100% 
Select DM Memory       
Channel: 9 (Empty) 
 CANCEL                      COPY

4-3                             bat:100% 
Erase MLS Memory & 
Setup Parameters 
 BACK                         ERASE

                                 
ERASE ALL DATA ! 
Are you sure? 
  CANCEL                  ERASE

                                 
Erasing... 
Wait... 
  

                                 
Verifying... 
done:100% 
  CANCEL

4-4                             bat:100% 
Copy MLS MEMORY & 
Setup From Panel 
 BACK                        SELECT

4-4-1                          bat:100% 
Select DM Memory       
Channel: 1 (Saving) 
 CANCEL                      COPY

4-4-9                          bat:100% 
Select DM Memory       
Channel: 9 (Empty) 
 CANCEL                      COPY

                                 
Copying... 
done:100% 
  CANCEL

                                 
Copying... 
Wait... 
  CANCEL

4-5                             bat:100% 
Write MLS MEMORY & 
Setup From Panel 
 BACK                        SELECT

4-5-1        (NL)           bat:100% 
MLS Setup & Memory 1     
(I=50A, EEESSSEEE) 
 CANCEL                     WRITE

4-5-9        (NL)           bat:100% 
MLS Setup & Memory 9     
(I=50A, EEEEEEEEE) 
 CANCEL                     WRITE

                                 
Programming EEPROM 
Wait... 
  

5                              bat:100% 
DATAMASTER II 
SETTTINGS 
                                SELECT

5-1                             bat:100% 
Restore DataMaster 
factory settings 
 BACK                    RESTORE

5-2                             bat:100% 
Erase all memory  

 BACK                        ERASE

 5-2-1                       bat:100%                                
All Memry will be! 
erased.Are you sure? 
  CANCEL                  ERASE

                                 
Erasing... 
Wait... 
  

(C) Cancel

START

COPY

ERASE

COPY

WRITE

ERASE

Wait / 
(C) Cancel

Wait / 
(C) Cancel

Wait / 
(C) Cancel

5-3                             bat:100% 
Backlight setting  

 BACK                        SELECT

 5-3-2                       bat:100%                                
Baclight automatic 
(Selected) 
  CANCEL                SELECT

 5-3-1                       bat:100%                                
Baclight OFF  

  CANCEL                SELECT

(C) Cancel

Wait

Wait

Wait

BACK / 
(C) Cancel

(C) Cancel

(C) Cancel

(C) Cancel

BACK / 
(C) Cancel

BACK / 
(C) Cancel

BACK / 
(C) Cancel

BACK / 
(C) Cancel

BACK / 
(C) Cancel

 5-3-3                       bat:100%                                
Baclight automatic 
time setting: 20s 
  ---                                  +++

(C) Cancel

4-6                             bat:100% 
Set MLS/S7 
Reset Delay 
 BACK                        SELECT

BACK / 
(C) Cancel

Set MLS/S7 
Reset Delay: 4 
(-|)=Save, (C)=Cancel 
    ---                                 +++
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6                              bat:100%  
DATAMASTER DLI 
MODES 
                                SELECT

6-1                             bat:100%  
DataMaster DLI6 
mode 
 BACK                        SELECT

6-1-1                          bat:100% 
DLI6 mode, (C)=Back 
Programm ing m ode=OFF 
 PROG_MODE            RESET

6-2                             bat:100%  
DataMaster DLI30 
mode 
 BACK                        SELECT

6-2-1                          bat:100% 
DLI30 m ode activated  

 BACK

7                              bat:100%  
CALIBRATION 
FUNCTIONS 
                                SELECT

7-1                           bat:100%  
DC MLS 
Calibration 
                                SELECT

7-1-1                        bat:100%  
Current Calibration  

 BACK                        START

CURRENT CALIBRATION 
Set Current to 5A 
Set offset: 000 
 ---                                    +++

CURRENT CALIBRATION 
Set Current to MAX 
Set m ultiplier: 000 
 ---                                    +++

7-1-2                        bat:100%  
Current Diplay 
Calibration 
 BACK                        START

CURRENT DISPLAY 
Set Current to 5A 
Set offset: 000 
 ---                                    +++

CURRENT DISPLAY 
Set Current to 43A 
Set offset: 000 
 ---                                    +++

CURRENT DISPLAY 
Set Current to 37A 
Set multiplier: 000 
 ---                                    +++

CURRENT DISPLAY 
Set Current to MAX 
Set multiplier: 000 
 ---                                    +++

7-1-3                        bat:100%  
Voltage Calibration  

 BACK                        START

VOLTAGE CALIBRATION 
Voltage Measurement 
Set multiplier: 000 
 ---                                    +++

VOLTAGE CALIBRATION 
No load voltage 80V 
Set reference: 000 
 ---                                    +++

VOLTAGE CALIBRATION 
No load voltage 40V 
Set offset: 000 
 ---                                    +++

7-1-4                        bat:100%  
Variable Voltage 
Calibration 
 BACK                        START

VARIABLE VOLTAGE 
Set voltageto 10V 
Set offset: 000 
 ---                                    +++

 sci                           bat:100%  
VARIABLE VOLTAGE 
Set voltageto 80V 
Set m ultiplier: 000 
 ---                                    +++

(C ) Cancel

(C ) Cancel

(C) Cancel

(C) Cancel

(C) Cancel

(C) Cancel

(C) C ancel

STAR T

(C) C ancel

STAR T

STAR T

STAR T

BACK / 
(C) Cancel

BACK / 
(C) Cancel

BACK / 
(C) Cancel

BACK / 
(C) Cancel
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7 -2                            b a t :1 0 0 %  
A C D C  M L S  
C a l ib ra tio n  
                                   S T A R T

C U R R E N T  O U T P U T  
(O u tp u t= 3 A ) 
S e t o f fs e t : 0 0 0  
 ---                                     + + +

C U R R E N T  IN P U T  
(P a n e l D is p la y= 3 A ) 
S e t  o f fse t :  0 0 0  
 ---                                    + + +

C U R R E N T  O U T P U T  
(O u tp u t= 2 0 0 A ) 
S e t m u lt ip lie r:  0 0 0  
 ---                                     + + +

C U R R E N T  IN P U T  
(P a n e l D is p la y= 2 0 0 A ) 
S e t  m u lt ip l ie r : 0 0 0  
 ---                                    + + +

V O L T A G E  IN P U T  
(P a n e l D ip la y= O u tp u t )  
S e t  m u lt ip l ie r : 0 0 0  
 ---                                    + + +

E X IT  C A L IB R A T IO N  
W rit in g  C a lib ra t io n  
V a lu e s.  W a it . ..                                      
  

E X IT  C A L IB R A T IO N  
C a l ib ra tio n  O K !   

  O K                                    

O K

(C ) C a n c e l

S T A R T

7 -3                            b a t :1 0 0 %  
K e m p a c t P u ls e  
C a l ib ra tio n  
                                   S T A R T

V O L T A G E  IN P U T  
(P a n  D is p la y= O u tp u t)  
S e t  m u lt ip l ie r : 0 0 0  
 ---                                    + + +

C U R R E N T  O U T P U T  
(O u tp u t= 0 A ) 
S e t  o f fse t :  0 0 0  
 ---                                    + + +

C U R R E N T  O U T P U T  
C o n n e ct  L o a d   

                           C O N T IN U E

C U R R E N T  IN P U T  
(P a n e l D is p la y= 2 0 0 A ) 
S e t  m u lt ip l ie r : 0 0 0  
 ---                                    + + +

E X IT  C A L IB R A T IO N  
W rit in g  C a lib ra t io n  
V a lu e s.  W a it . ..                                      
  

E X IT  C A L IB R A T IO N  
C a l ib ra tio n  O K !   

  O K                                    

O K

S T A R T

C O N T IN U E

(C ) C a n c e l

7 -4                            b a t :1 0 0 %  
M in a rc T IG  
C a l ib ra tio n  
                                   S T A R T

C U R R E N T  O U T P U T  
(O u tp u t= 5 A ) 
S e t o f fs e t : 0 0 0  
 ---                                     + + +

C U R R E N T  IN P U T  
(P a n e l D is p la y= 5 A ) 
S e t o f fs e t : 0 0 0  
 ---                                     + + +

C U R R E N T  O U T P U T  
(O u tp u t= 1 8 0 A ) 
S e t m u lt ip lie r:  0 0 0  
 ---                                     + + +

C U R R E N T  IN P U T  
(P a n e l D is p la y= 1 8 0 A ) 
S e t m u lt ip lie r:  0 0 0  
 ---                                     + + +

V O L T A G E  IN P U T  
(***V = O u tp u t )  
S e t m u lt ip lie r:  0 0 0  
 ---                                     + + +

E X IT  C A L IB R A T IO N  
C a lib ra t io n  O K !   

  O K                                    

O K

(C ) C a n c e l

S T A R T

O P E N  C IR C U IT  V O L T A G E  
(O u tp u t< 9 5 V ) 
S e t m u ltip lie r :  0 0 0  
 ---                                     + + +

O P E N  C IR C U IT  V O L T A G E  
(O u tp u t< 3 0 V ) 
S e t m u ltip lie r :  0 0 0  
 ---                                     + + +

V R DNO  V RD
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4.2.  Renesas Functions 
 
4.2.1. Program RENESAS flash memory using UART mode 
 
The 10-pin flat cable must be used in UART programming mode. This programming 
mode can be used with many up-to-date Kemppi products, such as Kempact pulse, 
MasterTIG MLS ACDC. 
 
1. Start DataMaster II and press Menu. 
2. Select Renesas Programming using UART mode. 
3. Use the up and down arrows to choose the program you want of programs 1 to 

13.  
4. Press START on the DataMaster II keypad to start the updating process. 
5. When DataMaster II display says: Connect Programmable Device, connect 

DataMaster II to welding machine and press CONTINUE.  
6. When updating is in progress, the DataMaster II display shows the progression of 

the process as a percentage value. If the progression stops, reset the DataMaster 
II by pressing ON/OFF key for 3 seconds, and start again. 

 
1                              bat:100% 
RENESAS FUNCTIONS  

                                SELECT

1-1                             bat:100% 
Renesas Programming 
Using UART mode 
 BACK                        SELECT

1-1-1        (34)           bat:100% 
Program 1                    (256Kb) 
(0A0 Kempact Panel               ) 
 CANCEL                     START

1-1-7        (0)             bat:100% 
Program 7                    (256Kb) 
( Empty                                   ) 
CANCEL                     START

1-1-8        (0)             bat:100% 
Program 8                    (128Kb) 
( Empty                                   ) 
CANCEL                     START

1-1-13       (0)             bat:100% 
Program 13                  (128Kb) 
( Empty                                   ) 
 CANCEL                     START

                                bat:100% 
Connect Programmable 
Device. 
 CANCEL             CONTINUE

                                 
Programming... 
done:100% 
  CANCEL

                                 
Verifying... 
done:100% 
  CANCEL

(C) Cancel

(C) Cancel

(C) Cancel

(C) Cancel
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4.2.2. Programming WeldForce panels 
 

The 10-pin flat cable must be used in WeldForce UART programming mode. 
 
1. Turn the welding machine off.  

Do not connect the DataMaster II to the WeldForce panel yet. 
2. Start the DataMaster II and press Menu. 
3. Select Renesas Programming using UART mode. 
4. Use the up and down arrows to choose the WeldForce program you want of 

programs 1 to 13.  
5. Press START on the DataMaster II keypad to start the updating process. 
6. When DataMaster II display says: Connect Programmable Device, connect the 

DataMaster II to the WeldForce panel.  
Note: All the panel's leds and displays should be off now. If they are on, 
reconnect the cable.  

 
 

7. Turn the welding machine on (optional). 
8. Press CONTINUE  to start programming. 
9. When updating is in progress, the DataMaster II display shows the progression of 

the process as a percentage value. In case of a programming error, press START 
again without reconnecting the cable. If the progression stops, reset the 
DataMaster II by pressing ON/OFF key for 3 seconds, and start again.  

 
1                              bat:100% 
RENESAS FUNCTIONS  

                                SELECT

1-1                             bat:100% 
Renesas Programming 
Using UART mode 
 BACK                        SELECT

1-1-1        (34)           bat:100% 
Program 1                    (256Kb) 
(0A0 Kempact Panel               ) 
 CANCEL                     START

1-1-7        (0)             bat:100% 
Program 7                    (256Kb) 
( Empty                                   ) 
CANCEL                     START

1-1-8        (0)             bat:100% 
Program 8                    (128Kb) 
( Empty                                   ) 
CANCEL                     START

1-1-13       (0)             bat:100% 
Program 13                  (128Kb) 
( Empty                                   ) 
 CANCEL                     START

                                bat:100% 
Connect Programmable 
Device. 
 CANCEL             CONTINUE

                                 
Programming... 
done:100% 
  CANCEL

                                 
Verifying... 
done:100% 
  CANCEL

(C) Cancel

(C) Cancel

(C) Cancel

(C) Cancel
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4.2.3. Programming RENESAS flash memory using CAN bus 
 
The PRO/CAN cable must be used in CAN programming mode. This programming 
mode can be used with FastMIG products. 
 
1. Start the DataMaster II and press Menu. 
2. Select Renesas Programming using CAN mode. 
3. DataMaster checks, which devices are connected to CAN bus. 
4. Use the up and down arrows to choose the device to be programmed of devices 0 

to 15 and press PROGRAM . 
5. Use the up and down arrows to choose the program you want of programs 1 to 

13. 
6. Press START on the DataMaster II keypad to start the updating process. 
7. When updating is in progress, the DataMaster II display shows the progression of 

the process as a percentage value. If the progression stops, reset the DataMaster 
II by pressing ON/OFF key for 3 seconds, and start again. 

 
 

1                              bat:100% 
RENESAS FUNCTIONS  

                                SELECT

1-1                             bat:100% 
Renesas Programming 
Using UART mode 
 BACK                        SELECT

1-2                             bat:100% 
Renesas Programming 
Using UART mode 
 BACK                        SELECT

                                 
Checking CAN Devices  
Wait... 
  CANCEL

DEVICE 0:                                
No Device  

  CANCEL

DEVICE 3:             PA001619                      
Panel 
00A2, Synergic 
  CANCEL            PROGRAM

DEVICE 15:                                
No Device  

  CANCEL

                                 
Programming:  57% 
Wait... 
  CANCEL

                (10)           
Program 1                    (256Kb) 
(SF,Syner,Panel,0A2              ) 
 CANCEL                     START

                (0)              
Program 13                  (128Kb) 
( Empty                                   ) 
 CANCEL                     START

                                
Programming  
Cancelled.! 

(C) Cancel

Program

(C) Cancel

(C) Cancel

                                 
Programming OK!  

                                        OK

OK

(C) Cancel

(C) Cancel

(C) Cancel
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4.2.4. Renesas setting 
 
4.2.3.1 Renesas baud rate selection 
 
You can select one of the following baud rate (speed) values for the Renesas 
programming. 

- 9600 
- 19200 
- 38400 (factory setting) 
- 57600 

 
Decreasing the baud rate makes the communication more reliable, but the 
programming time will be longer. 

 
 

4.2.3.2 Setting a new ID number 
 
A Renesas program needs an ID number that is compatible with the Renesas program 
(*mot file). In some cases this ID number may have to be changed. 
 
Factory setting: 00 00 00 00 00 00 00 
 
In case of an ID error, you must enter the correct ID number to DataMaster II device. 
 
Sometimes in error situations the ID number may be: FF FF FF FF FF FF FF. 
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4.3. Intel/Pro functions 
 
4.3.1. Writing a PRO program 
 
1. Turn the DataMaster II device on and press Menu. 
2. Select PRO FUNCTIONS. 
3. Select Write PRO Program. 
4. Use the up and down arrows to choose the program you want of PRO Programs  

1 to 7.  
5. Press START on the DataMaster II keypad to start the updating process. 
6. When updating is in progress, the DataMaster II display shows the progression of 

the process as a percentage value. If the progression stops, reset the DataMaster 
II by pressing ON/OFF key for 3 seconds, and start again. 

 

2                              bat:100% 
PRO FUNCTIONS  

                                SELECT

2-1                             bat:100% 
Write PRO Program  

 BACK                        SELECT

2-1-1        (34)           bat:100% 
Pro Program 1       
(4297600B6 PRO Evolution     ) 
 CANCEL                     START

2-1-7        (0)             bat:100% 
Pro Program 7  
( Empty                                   ) 
CANCEL                     START

                                 
Programming... 
done:100% 
  CANCEL

(C) Cancel

Wait / 
(C) Cancel

 
 
Note:  
For Pro programming you need the PRO/CAN cable. 
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4.4. Intel/AC/DC functions 
 
4.4.1. Writing an AC/DC program 
 
1. Start the DataMaster II and press Menu. 
2. Select AC/DC FUNCTIONS . 
3. Select Write AC/DC Program . 
4. Use the up and down arrows to choose the program you want of AC/DC 

Programs 1 to 5. 
5. Press START on the DataMaster II keypad to start the updating process. 
6. When updating is in progress, the DataMaster II display shows the progression of 

the process as a percentage value. If the progression stops, reset the DataMaster 
II by pressing ON/OFF key for 3 seconds, and start again. 

 

3                              bat:100% 
AC/DC FUNCTIONS  

                                SELECT

3-1                             bat:100% 
Write AC/DC Program  

 BACK                        SELECT

3-1-1        (34)           bat:100% 
AC/DC Program 1       
(4283180C0 AC/DC                 ) 
 CANCEL                     START

3-1-6        (0)             bat:100% 
AC/DC Program 5       
( Empty                                   ) 
 CANCEL                     START

                                 
Programming... 
done:100% 
  CANCEL

(C) Cancel

Wait / 
(C) Cancel

   
 
Note: 
For AC/DC programming you need the DataMaster II-AC/DC adapter. 
 
 
4.5. ST7/MLS Functions 
 
4.5.1. Writing an MLS Program 
 
1. Start the DataMaster II and press Menu. 
2. Select MLS FUNCTIONS . 
3. Select Write MLS Program . 
4. Use the up and down arrows to choose the program you want of MLS Programs 1 

to 9. 
5. Press START on the DataMaster II keypad to start the updating process. 
7. When updating is in progress, the DataMaster II display shows the progression of 

the process as a percentage value. If the progression stops, reset the DataMaster 
II by pressing ON/OFF key for 3 seconds, and start again. 

 
4                              bat:100% 
MLS FUNCTIONS  

                                SELECT

4-1                             bat:100% 
Write MLS Program  

 BACK                        SELECT

4-1-1        (NL)           bat:100% 
MLS Program 1       
(TIG Panel 0b0                        ) 
 CANCEL                     START

4-1-9        (0)              bat:100% 
MLS Program 9       
( Empty                                   ) 
 CANCEL                     START

                                 
Programming... 
done:100% 
  CANCEL

                                 
Verifying... 
done:100% 
  CANCEL

(C) Cancel

START

Wait / 
(C) Cancel
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4.5.2. Copying MLS program from panel to DataMaster 
 
Only Master MLS panel program and power source program can be copied from the 
welding machine to the DataMaster II device.  
 
4. Connect a 10-pin flat cable to the control panel or power source. 
5. Select MLS FUNCTIONS . 
6. Select Copy MLS Program. 
7. Use the up and down arrows to choose the DataMaster II memory block you 

want of memory channels 1 to 9. Message 'Saving' on DataMaster's display tells 
that there is already data in that DataMaster memory block.  

8. Press COPY to start copying the program. 
9. When updating is in progress, the DataMaster II display shows the progression of 

the process as a percentage value. If the progression stops, reset the DataMaster 
II by pressing ON/OFF key for 3 seconds, and start again. 

10. The copied program is now in DataMaster II memory, from where it and can be 
used for updating other welding machines.  

 
4                              bat:100% 
MLS FUNCTIONS  

                                SELECT

4-1                             bat:100% 
Write MLS Program  

 BACK                        SELECT

4-2                             bat:100% 
Copy MLS Program  

 BACK                        SELECT

4-2-1                          bat:100% 
Select DM Memory       
Channel: 1 (Saving) 
 CANCEL                      COPY

4-2-9                          bat:100% 
Select DM Memory       
Channel: 9 (Empty) 
 CANCEL                      COPY

                                 
Copying... 
done:100% 
  CANCEL

COPY

Wait / 
(C) Cancel

BACK / 
(C) Cancel

(C) Cancel
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4.5.3. Erasing MLS memory and setup parameters 
 
When you erase the MLS setup and memory settings, all values will be reset to 
factory settings and all memory channels will be empty. 
 

4                              bat:100% 
MLS FUNCTIONS  

                                SELECT

4-1                             bat:100% 
Write MLS Program  

 BACK                        SELECT

4-2                             bat:100% 
Copy MLS Program  

 BACK                        SELECT

4-3                             bat:100% 
Erase MLS Memory & 
Setup Parameters 
 BACK                         ERASE

                                 
ERASE ALL DATA ! 
Are you sure? 
  CANCEL                  ERASE

                                 
Erasing... 
Wait... 
  

ERASE

Wait

BACK / 
(C) Cancel

 
 

 
You should use the erase function when updating old MasterTIG MLS panel 
software or when the panel software is not working correctly. 
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4.5.4. Copying MLS memory and setup from panel 
 

4                              bat:100% 
MLS FUNCTIONS  

                                SELECT

4-1                             bat:100% 
Write MLS Program  

 BACK                        SELECT

4-2                             bat:100% 
Copy MLS Program  

 BACK                        SELECT

4-3                             bat:100% 
Erase MLS Memory & 
Setup Parameters 
 BACK                         ERASE

4-4                             bat:100% 
Copy MLS MEMORY & 
Setup From Panel 
 BACK                        SELECT

4-4-1                          bat:100% 
Select DM Memory       
Channel: 1 (Saving) 
 CANCEL                      COPY

4-4-9                          bat:100% 
Select DM Memory       
Channel: 9 (Empty) 
 CANCEL                      COPY

                                 
Copying... 
Wait... 
  CANCEL

COPY

Wait / 
(C) Cancel

(C) Cancel

(C) Cancel / 
BACK

 
   
 
1. Select Copy MLS Memory & Setup from Panel . 
2. Select the DataMaster memory block where you want to save the current setup 

and memory values.  
3. Press COPY, and DataMaster II reads the memory and setup values from the 

MLS Panel and saves it to DataMaster memory. 
4. When updating is in progress, the DataMaster II display shows the progression of 

the process as a percentage value. If the progression stops, reset the DataMaster 
II by pressing ON/OFF key for 3 seconds, and start again. 

 
Note:  
Message 'Saving' on DataMaster's display tells that there is already data in that 
DataMaster memory block. 
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4.5.5.  Writing MLS memory and setup to panel 
 
This function transmits all memory and setup values from DataMaster II to the panel. 
 

 
 
   
 

4                              bat:100% 
MLS FUNCTIONS  

                                SELECT

4-1                             bat:100% 
Write MLS Program  

 BACK                        SELECT

4-2                             bat:100% 
Copy MLS Program  

 BACK                        SELECT

4-3                             bat:100% 
Erase MLS Memory & 
Setup Parameters 
 BACK                         ERASE

4-4                             bat:100% 
Copy MLS MEMORY & 
Setup From Panel 
 BACK                        SELECT

4-5                             bat:100% 
Write MLS MEMORY & 
Setup From Panel 
 BACK                        SELECT

4-5-1        (NL)           bat:100% 
MLS Setup & Memory 1     
(I=50A, EEESSSEEE) 
 CANCEL                     WRITE

4-5-9        (NL)           bat:100% 
MLS Setup & Memory 9     
(I=50A, EEEEEEEEE) 
 CANCEL                     WRITE

                                 
Programming EEPROM 
Wait... 
  

WRITE

Wait

(C) Cancel / 
BACK

(C) Cancel

 
  
1. Select Write MLS Memory & Setup to Panel  from DataMaster's menu. 
2. Press WRITE, and the panel EEPROM updating process starts. 
3. When updating is in progress, the DataMaster II display shows the progression of 

the process as a percentage value. If the progression stops, reset the DataMaster 
II by pressing ON/OFF key for 3 seconds, and start again. 

 
Note:  
In DataMaster's display E = Empty and S = Saving. 
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4.5.6. Setting MLS/ST7 reset delay 
 
The default value for reset delay is 4 microseconds, which is close to the correct 
delay. You may need to change the reset delay value in order to correct programming 
error situations. The value can be altered until the ISP programming communicates 
reliably. 
 
 
4.6. DATAMASTER II SETTINGS 
 

5                              bat:100% 
DATAMASTER II 
SETTTINGS 
                                SELECT

5-1                             bat:100% 
Restore DataMaster 
factory settings 
 BACK                    RESTORE

5-2                             bat:100% 
Erase all memory  

 BACK                        ERASE

 5-2-1                       bat:100%                                
All Memry will be! 
erased.Are you sure? 
  CANCEL                  ERASE

                                 
Erasing... 
Wait... 
  

ERASE

5-3                             bat:100% 
Backlight setting  

 BACK                        SELECT

 5-3-2                       bat:100%                                
Baclight automatic 
(Selected) 
  CANCEL                SELECT

 5-3-1                       bat:100%                                
Baclight OFF  

  CANCEL                SELECT

(C) Cancel

Wait

BACK / 
(C) Cancel

BACK / 
(C) Cancel

 5-3-3                       bat:100%                                
Baclight automatic 
time setting: 20s 
  ---                                  +++

(C) Cancel

 
 
 
 
4.6.1. Restoring DataMaster factory setting 
 
This will reset all DataMaster settings to factory settings, but it does not empty the 
memory channels. 
 
4.6.2. Erase all memory 
 
This will empty all DataMaster memory channels. 
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4.6.3. Backlight setting 
 
Backlight OFF 
When using this setting the backlight is always off. 
 
Backlight automatic 
When using this setting the backlight is on when any key is pressed. 
 
Backlight automatic time setting 
This option lets the user set the duration, how long backlight is on when a key is 
pressed in the automatic mode. 
 
4.6.4. Backlight automatic time setting 
 
The user can select the duration, how long the DataMaster backlight is on when a 
key is pressed. 

- 5s 
- 20s (factory setting) 
- 40s 
- 60s 
- 90s 
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4.7. DataMaster II DLI modes 
 
 

6                              bat:100% 
DATAMASTER DLI 
MODES 
                                SELECT

6-1                             bat:100% 
DataMaster DLI6 
mode 
 BACK                        SELECT

6-1-1                          bat:100% 
DLI6 mode, (C)=Back 
Programming mode=OFF 
 PROG_MODE            RESET

6-2                             bat:100% 
DataMaster DLI30 
mode 
 BACK                        SELECT

6-2-1                          bat:100% 
DLI30 mode activated  

 BACK

(C) Cancel

BACK / 
(C) Cancel

BACK / 
(C) Cancel

 
 
 
 
4.7.1. DLI 6 Mode 
 
DataMaster works like a real DLI 6 device. When the DLI 6 mode is selected, it is 
not possible to use PC to DataMaster functions. You can exit DLI 6 mode by 
pressing Cancel or Back keys. 
 
PROG_MODE key can be used to change the Programming mode. This key works 
the same way as the program switching function in DLI 6.  
 
RESET key will reset the connected device (e.g. panel). 
 
When Programming mode=ON, the device (e.g. panel) can be programmed by using 
FlashSta program on your computer. 
 
 
4.7.2. DLI 30 Mode 
 
DataMaster works like a real DLI 6 device. When the DLI 6 mode is selected, it is 
not possible to use PC to DataMaster functions. You can exit DLI 6 mode by 
pressing Cancel or Back keys. 
 
When DLI 30 mode is ON the device (e.g. panel) can be programmed by using 
FastProgrammer program on your computer. 
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4.8. Calibration functions 
 
When using the calibration function, the DataMaster II device must be connected to 
the Power source with a special cable. A 10-pin cable should be connected between 
the DataMaster II device and the MLS power source. 
 
 
4.8.1. DC MLS calibration 
 

7                              bat:100% 
CALIBRATION 
FUNCTIONS 
                                SELECT

7-1                           bat:100% 
DC MLS 
Calibration 
                                SELECT

7-1-1                        bat:100% 
Current Calibration  

 BACK                        START

CURRENT CALIBRATION 
Set Current to 5A 
Set offset: 000 
 ---                                    +++

CURRENT CALIBRATION 
Set Current to MAX 
Set multiplier: 000 
 ---                                    +++

7-1-2                        bat:100% 
Current Diplay 
Calibration 
 BACK                        START

CURRENT DISPLAY 
Set Current to 5A 
Set offset: 000 
 ---                                    +++

CURRENT DISPLAY 
Set Current to 43A 
Set offset: 000 
 ---                                    +++

CURRENT DISPLAY 
Set Current to 37A 
Set multiplier: 000 
 ---                                    +++

CURRENT DISPLAY 
Set Current to MAX 
Set multiplier: 000 
 ---                                    +++

7-1-3                        bat:100% 
Voltage Calibration  

 BACK                        START

VOLTAGE CALIBRATION 
Voltage Measurement 
Set multiplier: 000 
 ---                                    +++

VOLTAGE CALIBRATION 
No load voltage 80V 
Set reference: 000 
 ---                                    +++

VOLTAGE CALIBRATION 
No load voltage 40V 
Set offset: 000 
 ---                                    +++

7-1-4                        bat:100% 
Variable Voltage 
Calibration 
 BACK                        START

VARIABLE VOLTAGE 
Set voltageto 10V 
Set offset: 000 
 ---                                    +++

 sci                           bat:100% 
VARIABLE VOLTAGE 
Set voltageto 80V 
Set multiplier: 000 
 ---                                    +++

(C) Cancel

(C) Cancel

(C) Cancel

(C) Cancel

(C) Cancel

(C) Cancel

START

(C) Cancel

START

START

START

BACK / 
(C) Cancel

BACK / 
(C) Cancel

BACK / 
(C) Cancel
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Current calibration 

 

7-1-1                        bat:100% 
Current Calibration  

 BACK                        START

CURRENT CALIBRATION 
Set Current to 5A 
Set offset: 000 
 ---                                    +++

CURRENT CALIBRATION 
Set Current to MAX 
Set multiplier: 000 
 ---                                    +++

START

(C) Cancel

 
 
 
1. Connect an external current and voltage meter to the power source. 
2. Turn the power source on. 
3. From the power source's control panel select TIG welding, and then select Pulse 

off. 
4. Set the panel setup jumper A3 to value 0 (TIG antifreeze = disabled). 
5. Set the panel current value to 5A, and select 4T function.  
6. Set the HF CONTACT setting to ON. 
7. Turn on the DataMaster II device and connect it to the power source. 
8. On the DataMaster II device select MLS CALIBRATION > CURRENT 

CALIBRATION . 
9. Connect the load to the welding machine. Cconnect LVR or similar load to 

MMA connectors. 
10. Set the load and press the torch start switch. If the power source does not start, 

change the load value and try again. 
11. Set the offset value using the ---/+++ keys on the DataMaster II keypad until the 

measured external current is as close as possible to 5A. Do not change the current 
value from the panel. 

12. Press down arrow key in DataMaster II keypad. 
13. Set current value to maximum from the panel. You may have to change the load 

value so that the current reaches its maximum value. 
14. Set the multiplier using the ---/+++ keys until the measured external current is as 

close as possible to the machine's maximum current value. 
15. Press Cancel (C) or down arrow key to end the calibration. 
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Current display calibration 

7-1-2                        bat:100% 
Current Diplay 
Calibration 
 BACK                        START

CURRENT DISPLAY 
Set Current to 5A 
Set offset: 000 
 ---                                    +++

CURRENT DISPLAY 
Set Current to 43A 
Set offset: 000 
 ---                                    +++

CURRENT DISPLAY 
Set Current to 37A 
Set multiplier: 000 
 ---                                    +++

CURRENT DISPLAY 
Set Current to MAX 
Set multiplier: 000 
 ---                                    +++

(C) Cancel

(C) Cancel

(C) Cancel

START

 
 

 
 
 
1. Press SELECT on DataMaster II to select the CURRENT DISPLAY 

CALIBRATION . 
2. Set the current value to 5A in the control panel. 
3. Set the load and press the torch start switch. If the power source does not start, 

change the load value and try again. 
4. Set the offset value using the ---/+++ keys on the DataMaster II keypad until the 

panel current display is as close as possible to 5A. 
5. Press the down arrow key on the DataMaster II keypad. 
6. Set the current to 43A on the panel. Wait 5 seconds, so that the measured current 

value appears on the panel display. Set the offset value using the ---/+++keys 
until the panel current display is as close as possible to 43A. 

7. Press the down arrow key on the DataMaster II keypad. 
8. Set the current to 37A from the panel. Wait 5 seconds, so that the measured 

current value appears on panel display. Set the multiplier value using the ---/+++ 
keys until the panel current display value is as close as possible to 37A.  

9. Press the down arrow key on the DataMaster II keypad. 
10. Set current value to maximum from the panel. Wait 5 seconds, so that the 

measured current value appears on panel display. Set the multiplier value using 
the ---/+++ keys until the panel current display value is as close as possible to the 
welding machine's maximum value. 

11. Finish the welding. 
12. Set the jumper A3 to its original position. 
13. Press Cancel (C) or down arrow key to end the calibration. 
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Voltage calibration 
 

7-1-3                        bat:100% 
Voltage Calibration  

 BACK                        START

VOLTAGE CALIBRATION 
Voltage Measurement 
Set multiplier: 000 
 ---                                    +++

VOLTAGE CALIBRATION 
No load voltage 80V 
Set reference: 000 
 ---                                    +++

VOLTAGE CALIBRATION 
No load voltage 40V 
Set offset: 000 
 ---                                    +++

(C) Cancel

(C) Cancel

START

 
 
1. Disconnect the load from the welding machine. 
2. From the DataMaster II device select MLS CALIBRATION > VOLTAGE 

CALIBRATION > VOLTAGE MEASUREMENT . 
3. Set the panel setup jumper A7 to value 0 (No load voltage = 80V). 
4. Select MMA welding  from the panel and wait a few seconds until the voltage 

reaches its maximum value. 
5. Set the multiplier value using the ---/+++ keys on the DataMaster II keypad until 

the panel voltage value on the display is as close as possible to the measured 
external voltage value. 

6. Press the down arrow key on the DataMaster II keypad. 
7. Set the voltage reference value using the ---/+++ keys until the measured external 

voltage value is as close as possible to 80V. 
8. Press the down arrow key on the DataMaster II keypad. 
9. Set the panel setup jumper A7 to value 1 (No load voltage = 40V). 
10. Set the offset value using the ---/+++ keys until the measured external voltage 

value is as close as possible to 40V. 
11. Press Cancel (C) or down arrow key to end the calibration. 
12. Disconnect the DataMaster II device and reset the setup jumper A7 to its original 

position. 
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Variable voltage calibration (MEX panel) 

7-1-4                        bat:100% 
Variable Voltage 
Calibration 
 BACK                        START

VARIABLE VOLTAGE 
Set voltageto 10V 
Set offset: 000 
 ---                                    +++

 sci                           bat:100% 
VARIABLE VOLTAGE 
Set voltageto 80V 
Set multiplier: 000 
 ---                                    +++

(C) Cancel

START

 
 

 
1. Connect DataMaster II to the power source 
2. Press SELECT from DataMaster II to select the option VARIABLE VOLTAGE 

CALIBRATION . 
3. Set the panel setup jumper A7 to value 0 (user define no load voltage = enabled) 

and set the jumper b3 to value 10 (No load voltage setting = 10V). 
4. Select MMA welding from the panel and wait a few seconds until the voltage 

reaches the maximum value. 
5. Set the offset using the ---/+++ keys on the DataMaster II keypad until the 

measured external voltage value is as close as possible to 10V. 
6. Press the down arrow key on the DataMaster II keypad. 
7. Set the panel setup jumper b3 to value 80 (no load voltage setting = 80V). 
8. Set the offset using the ---/+++ keys until the measured external voltage value is 

as close as possible to 80V. 
9. Press Cancel (C) or down arrow key to end the calibration. 
10. Reset the setup jumpers A7 and b3 to their original values. 
11. Disconnect DataMaster II from the power source. 
 



 

 KEMPPI OY  DataMaster II - 47 

4.8.2. ACDC MLS calibration 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
1. Connect DataMaster II to the power source.  
2. Connect an external current and voltage meter to the welding machine and turn 

the welding machine on.  
3. Connect LVR or similar load to MMA connectors. 
4. Select ACDC MLS CALIBRATION  and press Start key on the DataMaster II 

keypad. 
5. DataMaster II sets the panel values and selections automatically (TIG, DC, 3A) 

and starts the power source. 
6. Wait until the current is stabilized and the panel is in welding current state. 
7. Measure the output current and change the current output offset value by using 

the ---/+++ keys on the DataMaster II keypad until the measured output current is 
close to 3A. 

8. Press the down arrow key on the DataMaster II keypad. 
9. Change the Current input offset value by using the ---/+++ keys in DataMaster 

until the current value on the panel is close to 3A. 
10. Press the down arrow key on the DataMaster II keypad. 
11. DataMaster II sets the welding current automatically to MAX value. 
12. Change the Current output multiplier value by using the ---/+++ keys until the 

measured output current is close to MAX value. 
13. Press the down arrow key on the DataMaster II keypad. 

7-2                           bat:100% 
ACDC MLS 
Calibration 
                                   START

CURRENT OUTPUT 
(Output=3A) 
Set offset: 000 
 ---                                    +++

CURRENT INPUT 
(Panel Display=3A) 
Set offset: 000 
 ---                                    +++

CURRENT OUTPUT 
(Output=200A) 
Set multiplier: 000 
 ---                                    +++

CURRENT INPUT 
(Panel Display=200A) 
Set multiplier: 000 
 ---                                    +++

VOLTAGE INPUT 
(Panel Diplay=Output) 
Set multiplier: 000 
 ---                                    +++

EXIT CALIBRATION 
W riting Calibration 
Values. W ait...                                     
  

EXIT CALIBRATION 
Calibration OK!  

  OK                                   

OK

(C) Cancel

START
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14. Change the current input multiplier value by using the ---/+++ keys until the 
current value on the panel is close to MAX value. 

15. Press the down arrow key on the DataMaster II keypad. 
16. DataMaster sets the welding current automatically to MAX/2  (voltage calibration 

is made when power source is on and welding current is MAX/2). 
17. Change the voltage input multiplier value by using the ---/+++ keys until the 

voltage value on the panel is close to the measured voltage. 
18. Press Cancel (C) or down arrow key to end the calibration. 
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4.8.3. Kempact pulse calibration 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
1. Connect DataMaster II to the Power Source.  
2. Connect an external current and voltage meter to the welding machine. Do not 

connect load. 
3. Select KEMPACT PULSE CALIBRATION  and press START on the 

DataMaster II keypad. 
4. Wait until the voltage is stabilized and the panel is in welding current state. 
5. Measure the output voltage and change the voltage input multiplier value by 

using the ---/+++ keys on the DataMaster keypad until the measured output 
voltage is close to the panel value. 

6. Press the down arrow key on the DataMaster II keypad. 
7. Change the current output offset value by using the ---/+++ keys until the current 

value on the panel is close to 0A. 
8. Press the down arrow key on the DataMaster II keypad. 
9. Connect the load to the welding machine. 
10. Press CONTINUE on the DataMaster II keypad. 
11. Change the current output multiplier value by using the ---/+++ keys until the 

measured output current is close to the panel value. 
12. Press Cancel (C) or down arrow key to end the calibration.

7-3                           bat:100% 
Kempact Pulse 
Calibration 
                                   START

VOLTAGE INPUT 
(Pan Display=Output) 
Set multiplier: 000 
 ---                                    +++

CURRENT OUTPUT 
(Output=0A) 
Set offset: 000 
 ---                                    +++

CURRENT OUTPUT 
Connect Load  

                           CONTINUE

CURRENT INPUT 
(Panel Display=200A) 
Set multiplier: 000 
 ---                                    +++

EXIT CALIBRATION 
Writing Calibration 
Values. Wait...                                     
  

EXIT CALIBRATION 
Calibration OK!  

  OK                                   

OK

START

CONTINUE

(C) Cancel
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12.1.1. MinarcTIG calibration 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
1. Disconnect connector X2 (Spark on/off) from the spark generator card A002 
2. Turn on the welding machine and the DataMaster II device. 
3. Connect the DataMaster II device to MinarcTIG panel.  
4. Connect an external current and voltage meter to the welding machine and turn 

the welding machine on (connect load to MMA connectors) (LVR or similar). 
5. Select MINARCTIG CALIBRATION . 
6. Set panel settings TIG, HF, 4T,  and 5A. Set appropriate load (LVR load 25 / 

MinarcTig 180). Start welding by pressing the torch start switch. 
7. Wait until the current is stabilized and the panel is in welding current state. 
8. Measure the output current and change the current output offset value by using 

the ---/+++ keys on the DataMaster II keypad until the measured output current is 
close to 5A. 
 

7-4                           bat:100% 
MinarcTIG 
Calibration 
                                   START

CURRENT OUTPUT 
(Output=5A) 
Set offset: 000 
 ---                                    +++

CURRENT INPUT 
(Panel Display=5A) 
Set offset: 000 
 ---                                    +++

CURRENT OUTPUT 
(Output=MAX) 
Set multiplier: 000 
 ---                                    +++

CURRENT INPUT 
(Panel Display=MAX) 
Set multiplier: 000 
 ---                                    +++

VOLTAGE INPUT 
(***V=Output) 
Set multiplier: 000 
 ---                                    +++

EXIT CALIBRATION 
Calibration OK!  

  OK                                   

OK

(C) Cancel

START

OPEN CIRCUIT VOLTAGE 
(Output<95V) 
Set multiplier: 000 
 ---                                    +++

OPEN CIRCUIT VOLTAGE 
(Output<30V) 
Set multiplier: 000 
 ---                                    +++

VRDNO VRD
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If the welding machine turns off by itself, press the down arrow key on the 
DataMaster II keypad. Decrease the current input offset value by using the ---, 
press the up arrow  key on the DataMaster II keypad and repeat steps 6, 7. and 8. 
 

9. Press the down arrow key on the DataMaster II keypad. 
10. Change the current input offset value by using the ---/+++ keys until the current 

value on the panel is close to 5A. 
11. Press the down arrow key on the DataMaster II keypad. 
12. Set current value to MAX  from the panel. You may have to change the load 

value so that the current reaches the desired value (LVR load 200 + 100 / 
MinarcTig 180 ). 

13. Change the current output multiplier value by using the ---/+++ keys until the 
measured output current is close to Max. 

14. Press the down arrow key on the DataMaster II keypad. 
15. Change the current input multiplier value by using the ---/+++ keys in 

DataMaster until the current value on the panel is close to Max. 
16. Press the down arrow key on the DataMaster II keypad. 
17. Set current value to 50A and change the load values so that the measured output 

voltage is close to 30V (LVR load 50 / MinarcTig 180). 
18. Change the voltage input multiplier value by using the ---/+++ keys until the 

DataMaster voltage value on the panel is close to the measured value. Stop 
welding by pressing the torch start switch. 

19. Press the down arrow key on the DataMaster II keypad. 
20. Take the load off and turn the welding machine to MMA  mode. 
21. Change the voltage output multiplier value by using the ---/+++ keys until the 

measured voltage is under 95V or in VRD machines under 30V. 
Press Cancel (C) or down arrow key to end the calibration. 
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4.9. DataMaster 'Auto OFF' feature 
 
If DataMaster II is idle for 10 minutes, the device is automatically turned OFF. 
 
The 'Auto OFF' feature is not activated, when 

• DataMaster is connected to the charger 
• DataMaster is in DLI mode 
• Data transfer is in progress between DataMaster and PC. 

 
 
4.10. Special function keys A-F 
 
The special function keys A-F on DataMaster keypad can be used for menu 
shortcuts. When a menu is on display, the number of the menu can be saved to any of 
these keys by a long key press. For example, if you want to save the current menu's 
shortcut to the key 'A', you must press and hold the key, until you see the message: 
'Menu number is saved to key A'. Now, when you press key 'A' again, DataMaster 
will jump directly to the saved menu number. 
 
4.11. DataMaster reset key function 
 
Sometimes it may be necessary to reset the DataMaster II device, if the device 
doesn't respond to key presses. This can be done by pressing ON/OFF and RESET 
keys simultaneously for at least 3 seconds. Reset operation will turn the DataMaster 
II device OFF. After the reset DataMaster II can be turned on normally by pressing 
the ON/OFF key. 
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5. DATAMASTER II MAINTENANCE 
 
5.1.  MAINTENANCE 
 
Product maintenance routines depend on the utilisation rate and the operation 
environment of the device. Cautious use and preventive maintenance help to avoid 
unnecessary production disturbances and breaks. 
 
12.1.2. Battery maintenance 
 
• Always prepare brand new batteries for the first use. When charging the battery 

for the first time keep the battery in the charger approximately 50% longer time 
than in a normal charge. DO THIS ONLY IN THE FIRST CHARGING.  

• Before recharging the battery, wait until DataMaster II battery indicator is low 
(2-10%).  

• Do not let the DataMaster II device stay in a charger any longer than is 
necessary. When the battery is full, remove the device from the charger. 

 
5.1.  ORDERING NUMBERS 
 
DataMaster II   6265041 
DataMaster II CD   W002409 
Battery     4301110T 
LCD module    4301180T 
Strap     9592161 
Charger    9777812 
Keyboard    3149680 
RS-cable    9720822 
PRO/CAN-cable   4298780 
ISP flat cable    W002408 
UBS-cable    9770642 
DataMaster II-AC/DC adapter 4302380 
FastMIG Basic 10/7 cable  4298790 
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5.2. TROUBLESHOOTING 
 
12.1.3. Troubleshooting the DataMaster II 
 
 
DataMaster II won't turn on. 
• Battery may be empty or damaged. Recharge the battery or replace it  

with a new one. 
• If the problem persists, disconnect all cables and press and hold the reset key for 

a long time (>4s), then try to turn on the DataMaster II. 
 
 
DataMaster II turns off unexpectedly. 
• If a separate control panel is connected to DataMaster II, the battery level may 

fall so much that the DataMaster II turns off.  
• Connect DataMaster II to an external power source. 
 
 
DataMaster II battery won’t recharge 
• Battery may already be full. Check if the percent value is 100%. 
• Charger may be damaged. Replace the charger. 
• Battery may be damaged. Replace battery. Only same type of battery must be 

used. 
• Charger adapter coupling may be wrong. Change the charger adapter polarity. 

Correct polarity: tip = positive, frame = negative.  
 
 
Connection between PC and DataMaster II won't work 
• The may be a problem with the connection cable.  

Check the RS/USB cable. 
• The DataMaster II device may be turned off. Turn DataMaster II on. 
• If the problem persists, reset DataMaster II. 
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12.1.4. Troubleshooting the programming routines 
 
If there is a problem with the programming routine, do the following: 
• Check that the target board is correctly powered. 
• Make sure that all connections are correct. 
• Check that the correct device is connected to the socket and that it is right way 

round. 
• Check that the MLS programming flat cable or PRO/CAN cable is correctly 

connected. 
• If the problem persists, restart the welding machine and DataMaster II. 
 
12.1.5. Troubleshooting the calibration routines 
 
The power source won't start or the voltage won't rise. 
• There may be a wrong menu in the display. Check the manual to select the right 

menu function. 
• There may be a faulty connection between the DataMaster II and the welding 

machine. Check all connections. 
• The value of the external load may be wrong. 
 
The connection between DataMaster II and Power source won't work ('Wait' is 
displayed). 
• There may be a faulty connection. Check all DataMaster II connections. 
• Select Cancel and start again. 
 
The Power Source shuts down when changing the offset value. 
• The load value may be wrong. Try changing the load value so that the output 

voltage is in allowed range. 
 
12.1.6. Flash memory read error! (Recharge battery) 
 
In the case of a flash memory read error the battery voltage may be low and the 
DataMaster memory won't ´work correctly. Try recharging the battery and resetting 
the DataMaster. 
 
 
5.3. RECYCLING THE MACHINE 
 
Kemppi machines are mainly produced of recyclable materials. When disposing of 
the used-up product, you should deliver the used device to a treatment plant, where it 
is possible to separate the materials from each other for recycling. 
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6. TECHNICAL DATA AND TERMS OF GUARANTEE 
 
6.1.  TECHNICAL DATA 
 
DataMaster II 
DataMaster II parts  DataMaster II unit 
    Charger 
    Strap 
    DataMaster II program CD 

ISP interface flat cable 
    PRO/CAN interface cable 
    RS-232 cable 

USB cable 
    DataMaster II - AC/DC adapter 
 
Dimensions   Length  225mm 
    Width  148mm 
    Height  37/79mm 
    Weight  790g 
 
Interfaces   12V DC charger connection 
    ISP/SCI programming/calibration interface 
    PRO bus interface 
    RS-232 PC interface 

USB interface (virtual COM port) 
 
Battery    NiMh 1500mA / 6V 
 
Power consumption  Backlight OFF: 110mA 
    Backlight ON:  85mA 
 
Charger   Input 230VAC 50Hz 
    Output: 12VDC 600mA 7.2VA 
    Connector TIP = positive (+), frame = negative (-). 
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6.2. TERMS OF QUARANTEE 
 
KEMPPI OY provides a guarantee for products manufactured and sold by them if 
defects in manufacture and material occur. Guarantee repairs must be carried out 
only by an authorised KEMPPI service workshop. Packing, freight and insurance 
cost are to be paid by third party. The guarantee takes effect on the day of purchase. 
Verbal promises which do not comply with the terms of guarantee are not binding on 
guarantor. 
 
Limitations on guarantee 
 
The following conditions are not covered by the terms of guarantee: defects due to 
fair wear and tear, non-compliance with operating and maintenance instructions, 
connection to incorrect or faulty supply voltage (including voltage surges outside 
equipment spec.), transport or storage damage, fire or damage due to natural causes 
i.e. lightning or flooding.  
 
This guarantee does not cover direct or indirect travelling costs, daily allowances or 
accommodation. Direct or indirect damage due to a defective product is not covered 
under the guarantee. 
 
The guarantee is void if changes are made to the product without approval of the 
manufacturer, or if repairs are carried out using non-approved spare parts. 
The guarantee is also void if repairs are carried out by non-authorised workshop. 
 
Undertaking guarantee repairs 
 
Guarantee defects must be informed to KEMPPI or authorised KEMPPI Service 
Workshop within the guarantee period. Before any guarantee work is undertaken, the 
customer must provide a proof of the purchase and the serial number of the 
equipment in order to validate the guarantee. 
The parts replaced under the terms of guarantee remain the property of KEMPPI. 
Following a guarantee repair, the guarantee of the machine or equipment, repaired or 
replaced, will be continued till the end of the original guarantee period. 
 


